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INTRODUCTION 

This report and associated keyboard layouts and mapping tables have been developed at the 
request of, and in consultation with the Australian Saay Harari Association, in Melbourne, 
Australia.  

The Australian Saay Harari Association has adopted a Latin orthography to facilitate teaching 
their children the Harari language. There is also an awareness of the need to facilitate the use of 
the Ethiopic script, and provide mechanisms to facilitate its use. To achieve this, this report 
adopts two approaches: 

 Develop an Ethiopic input device that uses exactly the same input sequences for Latin and 
Ethiopic orthographies, i.e. allows a student familiar with the Latin orthography to type 
in the Ethiopic orthography. 

 Develop mapping tables allowing content to be written in the Latin script and then 
automatically converted to the Ethiopic script. 

The Harari keyboard project will develop Latin script keyboard solutions for the following 
platforms: 

1. Tavultesoft Keyman Desktop 

2. Microsoft Win32 keyboard layouts 

3. MacOS 10.2+ XML keyboard layouts 

The MacOS and Microsoft Win32 keyboard layouts are under development. It is important to note 
that Keyman Desktop is a commercial product. There are two versions: Professional and Light. 
Keyman Desktop Light can only install a maximum of two keyboard layouts. Keyman Desktop 
Professional has no restrictions. 

The MacOS and Microsoft Win32 keyboards are free. 

Three keyboard layouts have been developed that share a common input method, they are based 
on the input system that follows the Latin orthography:  

 Harari (Lâtîn harfi) 

 Harari (Sabai harfi) 

 Harari (Arabi harfi) 

All three keyboards type the same way, allowing students who learn the Latin orthography to 
also type in the Ethiopic and Arabic orthographies. 

For those users who are unfamiliar with the Latin orthography two additional keyboard layouts 
have been developed: 

 Harari (Sabai muxxi harfi) 
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 Harari (Arabi muxxi harfi), which is based on the  

 

Table 1: Available keyboard solutions 

Keyboard Keyman 
Microsoft Win32 

keyboard 
MacOS 

Harari (Lâtîn harfi) YES YES YES 

Harari (Sabai harfi) YES   

Harari (Sabai muxxi harfi) YES YES YES 

Harari (Arabi harfi) YES   

Harari (Arabi muxxi harfi) YES YES YES 
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INSTALLING HARARI KEYBOARD LAYOUTS 

Tavultesoft Keyman Desktop is a commercial product. There are two versions: Light and 
Professional. The Light version allows you to install two keyboard layouts. The professional 
version allows you to install many more layouts. It is available for download and purchase 
from the Tavultesoft website (http://www.tavultesoft.com/). Trial versions of Keyman 
Desktop have been included on the Harari 2.0 CD-ROM. 

Free Microsoft style keyboard layouts are available for the Harari Latin orthography. Ethiopic 
and Arabic versions that sue the Latin input system can not be implemented using Microsoft 
specific tools. 

 

INSTALLING TAVULTESOFT KEYMAN 

 Insert the Harari 2.0 CD-Rom into your computer’s CD/DVD drive 

 Open the CD-Rom in Windows Explorer 

 Enter the Keyman folder 

 Double click on Keyman Desktop files: 

o Double click on keymandesktoplight-7.1.263.0.exe if you wish to install Keyman 
Desktop Light 

o Double click on keymandesktoppro-7.1.263.0.exe if you wish to install Keyman 
Desktop Professional 

 Follow the instructions on the install window 

 

INSTALLING KEYMAN KEYBOARD PACKAGES 

After you install Keyman you can install the Harari keyboard packages. 

 Insert CD-Rom into computer, and navigate to the Keyman folder on the CD-rom 

 To install the keyboard packages for the 

o Latin orthography, double click on the file harlatn.kmp 

o Ethiopic orthography, double click on the file harethi.kmp or 
harethialt.kmp 

o Arabic orthography, double click on the filehararab.kmp or hararabalt.kmp 
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LATIN ORTHOGRAPHY 

 

a â ȧ b c ch d dh ḋ e ê f 

g gh gn h ḣ i î j k kh l m

n o ô p q r s sh ṡ t ṫ u 

û v w x xh y z zh ż    
  

A Â Ȧ B C Ch D Dh Ḋ E Ê F

G Gh Gn H Ḣ I Î J K Kh L M

N O Ô P Q R S Sh Ṡ T Ṫ U

Û V W X Xh Y Z Zh Ż    
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NOTES 

Long vowels: â, ê, î, ô, û  
Letter’s required for English words: p, v  
Letters required for Arabic words:  dh, ḋ, ḣ, gh, ṡ, ṫ, ż  

THE CHARACTER ʼ 

The character ʼ:  

1) indicates that the preceding consonant is an isolated consonant rather than part of a 
digraph, e.g. hêgʼna (ሔ́ግነ,  َحٛىݘْن - replace) , i.e. gʼn is “g+n” rather than “gn”. 

2) distinguishes between a double digraph and a consonant followed by digraph, 
magʼgna (መግኘ,  َمَݘْڹ - throwing)  i.e. gʼgn is “g+gn” rather than “ggn”. 

3) distinguishes between a consonant and an isolated vowel Gaz’i (ገዝኢ,  ِٕݘَزْا - God); or 
4) following a vowel it indicates that the vowel is stressed raʼyi (ረእዪ,  ِرَأْي - idea) or usuʼ 

(ኡሱእ,  ْأُسُؤ - people).   

UNICODE CODEPOINTS 

 

Lowercase  Uppercase 

Glyph Codepoint(s)  Glyph Codepoint(s) 

â U+00E2 
 Â U+00C2 

ȧ U+0227 
 Ȧ U+0226 

ḋ U+1E0B 
 Ḋ U+1E0A 

ê U+00EA 
 Ê U+00CA 
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Lowercase  Uppercase 

Glyph Codepoint(s)  Glyph Codepoint(s) 

ḣ U+1E23 
 Ḣ U+1E22 

î U+00EE 
 Î U+00CE 

ô U+00F4 
 Ô U+00D4 

ṡ U+1E61 
 Ṡ U+1E60 

ṫ U+1E6B 
 Ṫ U+1E6A 

û U+00FB 
 Û U+00DB 

ż U+017C 
 Ż U+017B 

ʼ U+02BC 
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TYPING HARARI IN THE LATIN SCRIPT 

CHARACTER SEQUENCES FOR INPUT FOR KEYMAN: 

 

Diacritic Base characters Key sequence 

◌ ̂ a e i o u A E I O U Vowel + “[” 

◌ ̇ a d h s t z A D H S T Z Character + “]” 

 

Modifier letter Key sequence 

ʼ “\” 
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KEYBOARD LAYOUT 

NORMAL (UNSHIFTED) 

 

SHIFT 

 

RIGHT ALT 

 

SHIFT+RIGHT ALT 

 



    13 

 

HARARI (SABAI HARFI) 
 

 a u i a[ e  o e[ i[ o[ u[ 

h] ሀ ሁ ሂ ሃ ሄ ህ ሆ ሄ ́ ሂ ́ ሆ́ ሁ́ 

l ለ ሉ ሊ ላ ሌ ል ሎ ሌ́ ሊ́ ሎ́ ሉ́ 

h ሐ ሑ ሒ ሓ ሔ ሕ ሖ ሔ́ ሒ́ ሖ ́ ሑ́ 

m መ ሙ ሚ ማ ሜ ም ሞ ሜ́ ሚ́ ሞ ́ ሙ́ 

t] ሠ ሡ ሢ ሣ ሤ ሥ ሦ ሤ́ ሢ́ ሦ ́ ሡ́ 

r ረ ሩ ሪ ራ ሬ ር ሮ ሬ ́ ሪ ́ ሮ ́ ሩ ́

s ሰ ሱ ሲ ሳ ሴ ስ ሶ ሴ́ ሲ́ ሶ ́ ሱ́ 

sh ሸ ሹ ሺ ሻ ሼ ሽ ሾ ሼ ́ ሺ́ ሾ ́ ሹ́ 

q ቀ ቁ ቂ ቃ ቄ ቅ ቆ ቄ ́ ቂ ́ ቆ ́ ቁ ́

b በ ቡ ቢ ባ ቤ ብ ቦ ቤ́ ቢ́ ቦ ́ ቡ́ 

t ተ ቱ ቲ ታ ቴ ት ቶ ቴ ́ ቲ ́ ቶ ́ ቱ ́

ch ቸ ቹ ቺ ቻ ቼ ች ቾ ቼ ́ ቺ ́ ቾ ́ ቹ ́

gh ኀ ኁ ኂ ኃ ኄ ኅ ኆ ኄ ́ ኂ ́ ኆ ́ ኁ́ 
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 a u i a[ e  o e[ i[ o[ u[ 

n ነ ኑ ኒ ና ኔ ን ኖ ኔ ́ ኒ ́ ኖ ́ ኑ́ 

gn ኘ ኙ ኚ ኛ ኜ ኝ ኞ ኜ ́ ኚ ́ ኞ ́ ኙ́ 

 አ ኡ ኢ ኣ ኤ እ ኦ ኤ́ ኢ́ ኦ ́ ኡ́ 

k ከ ኩ ኪ ካ ኬ ክ ኮ ኬ́ ኪ́ ኮ ́ ኩ́ 

kh ኸ ኹ ኺ ኻ ኼ ኽ ኾ ኼ́ ኺ́ ኾ́ ኹ́ 

w ወ ዉ ዊ ዋ ዌ ው ዎ ዌ ́ ዊ ́ ዎ ́ ዉ́ 

a] ዐ ዑ ዒ ዓ ዔ ዕ ዖ ዔ́ ዒ́ ዖ ́ ዑ́ 

z  ዘ ዙ ዚ ዛ ዜ ዝ ዞ ዜ ́ ዚ́ ዞ ́ ዙ́ 

zh ዠ ዡ ዢ ዣ ዤ ዥ ዦ ዤ́ ዢ́ ዦ́ ዡ́ 

dh ፀ ፁ ፂ ፃ ፄ ፅ ፆ ፄ ́ ፂ ́ ፆ ́ ፁ́ 

y የ ዩ ዪ ያ ዬ ይ ዮ ዬ́ ዪ́ ዮ ́ ዩ ́

d ደ ዱ ዲ ዳ ዴ ድ ዶ ዴ́ ዲ ́ ዶ ́ ዱ́ 

xh ዸ ዹ ዺ ዻ ዼ ዽ ዾ ዼ́ ዺ ́ ዾ ́ ዹ́ 

j ጀ ጁ ጂ ጃ ጄ ጅ ጆ ጄ́ ጂ ́ ጆ ́ ጁ́ 

g ገ ጉ ጊ ጋ ጌ ግ ጎ ጌ ́ ጊ́ ጎ ́ ጉ́ 
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 a u i a[ e  o e[ i[ o[ u[ 

x ጠ ጡ ጢ ጣ ጤ ጥ ጦ ጤ́ ጢ́ ጦ ́ ጡ́ 

c ጨ ጩ ጪ ጫ ጬ ጭ ጮ ጬ́ ጪ́ ጮ́ ጩ́ 

d] ጰ ጱ ጲ ጳ ጴ ጵ ጶ ጴ́ ጲ́ ጶ ́ ጱ́ 

s] ጸ ጹ ጺ ጻ ጼ ጽ ጾ ጼ́ ጺ́ ጾ ́ ጹ́ 

f ፈ ፉ ፊ ፋ ፌ ፍ ፎ ፌ́ ፊ ́ ፎ ́ ፉ ́

p ፐ ፑ ፒ ፓ ፔ ፕ ፖ ፔ ́ ፒ ́ ፖ ́ ፑ ́

v ቨ ቩ ቪ ቫ ቬ ቭ ቮ ቬ́ ቪ́ ቮ ́ ቩ́ 

z] ⶰ ⶱ ⶲ ⶳ ⶴ ⶵ ⶶ ⶴ́ ⶲ́ ⶶ́ ⶱ́ 

 

a\ e\ i\ o\ u\ a[\ e[\ i[\ o[\ u[\ 

አእ ኤእ ኢእ ኦእ ኡእ ኣእ ኤ̂እ ኢ̂እ ኦእ̂ ኡ̂እ 

 

 

 



16 

HARARI (SABAI MUXXI HARFI) 

NORMAL 

 

SHIFT 

 

ALTGR (RIGHT ALT) 

 

SHIFT + ALTGR (RIGHT ALT) 
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HARARI (ARABI HARFI) 

CONSONANTS 

 Isolated Code point 

a] ع U+0639 

b ب U+0628 

c ڟ U+069F 

ch ڛ U+069B 

d د U+062F 

dh ذ U+0630 

d] ض U+0636 

f ف U+0641 

g ݘ U+0758 

gh غ U+063A 

gn ڹ U+0767 

h ح U+062D 

h] ه U+0647 
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 Isolated Code point 

j ج U+062C 

k ك U+0643 

kh خ U+062E 

l ل U+0644 

m م U+0645 

n ن U+0646 

p پ U+067E 

q ق U+0642 

r ر U+0631 

s س U+0633 

sh ش U+0634 

s] ص U+0635 

t ت U+062A 

t] ث U+062B 
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 Isolated Code point 

v ڤ U+06A4 

w و U+0648 

x ط U+0637 

xh ڬ U+06AC 

y ي U+064A 

z ز U+0632 

zh ژ U+0698 

z] ظ U+0638 
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DEPENDANT VOWELS 
 

Vowel Short  
type: vowel 

Long  
type: vowel + [ 

Short stressed 
type: vowel + \ 

Long stressed 
type: vowel + [ + \ 

a  َباَءْ  بأَْ  باَ  ب 

e  ٛبىٛءْ  بىْٛٔ  بىٛ ب 

i  ِبِىءْ  بِىْٔ  بِى ب 

o  ٚبوٚءْ  بؤْٚ  بوٚ ب 

u  ُبوُءْ  بؤُْ  بوُ ب 

INDEPENDENT VOWELS 
 

Vowel Short  
type: vowel 

Long  
type: vowel + [ 

Short stressed 
type: vowel + \ 

Long stressed 
type: vowel + [ + \ 

a  َٔءَاءْ  ءَأْ  ءَا  ا 

e  ٛ  اىٕٛءْ  ءٛىْٔ  اىٕٛ إ

i  ِٕإِىءْ  ءِىْٔ  إِى ا 

o  ٚٔأوٚءْ  ءٚؤْ  أوٚ ا 

u  ُٔأُوءْ  ءُؤْ  أُو ا 



21 

HARARI (ARABI MUXXI HARFI) 

NORMAL 

 

SHIFT 

 

ALTGR (RIGHT ALT) 

 

SHIFT + ALTGR (RIGHT ALT) 
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MAPPING FILES 

Two mapping files have been developed using SIL Encoding Converters  

1. Harari Latin to Ethiopic.  
This mapping converted between the Latin and Ethiopic orthographies used in this 
document. It is important to note that: 

a. The Ethiopic script is unicameral while the Latin script is bicameral. When you 
convert from Ethiopic to Latin, all text is in lowercase. Select the text and convert 
the casing to sentence casing.  

b. It is necessary to manually check the document after the document has been 
converted. 

2. Strip long vowels from Harari text written in the Ethiopic script. 

 

INSTALLING SIL ENCODING CONVERTERS 

 Insert the Harari 2.0 CD-Rom into your computer’s CD/DVD drive 

 Open the CD-Rom in Windows Explorer 

 Enter the conversion folder 

 Enter the SIL_Converters folder 

 Double click on the setup.exe file 

 

 Select SIL Converters and Repository 3.0 and click on the OK button 
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 Click on the Next button 

 



    24 

 Click on the Next button 

 

 Click on the Next button 
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 Click on the Next button 

 Follow the instructions on the install window 

 Click on the Finish button 

 

INSTALLING HARARI MAPPING FILES 

 Start up Microsoft Word. Within word there is a new toolbar: 

 

 Select some text and click on the “Convert selection” button. 
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 Click on the Select a convertor field 
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 Click on the Add New button 

 

 Click on TECkit map 

 Click on the Add button 

 In the new dialog box, click on the Setup tab 
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 Click on the “…” button and navigate to the conversion folder on the CD-Rom. 

 Select the har-latn2ethi.tec file. 

 Click on the Save in Repository button 

 Give the file a name, e.g. Harari Latin <> Ethiopic 

 Click on the OK button 

 Click on the OK button on each screen to exit 

USING HARARI MAPPING FILES 

 Start up Microsoft Word. Open up the document you wish to convert. 
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 Select the text you wish to convert and click on the “Convert selection” button. 

 

 Click on the Select a convertor field 
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 Select on Harari Latin <> Ethiopic converter 

 Click on the OK button 

 Click on the Select a font to apply field 

 

 Select the required font for converted text, e.g. Abyssinica SIL and click on the OK button 
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 Click on the Replace All button 
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FONTS 

Suitable fonts for the Harari Latin orthography are available in the Fonts folder of the Harari 2.0 
CD-Rom. 

WINDOWS VISTA 

 

1. Click on the Start button, go to the Control Panel 

2. Click on Fonts 
 
Alternatively, use the run command to execute the following command: 

control Fonts 

 

3. Right mouse click in the font list, and select Install New Font from the context menu 
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4. Navigate to the directory fonts have been downloaded to, and select fonts to install. You can 
select more than one font at a tie. 

 

5. Click on the Install button 
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WINDOWS XP 

 

To install fonts: 

1. Download the fonts, unzip and store the fonts in a temporary directory, e.g. 
C:\TEMP.  

 

2. Click the Start button, and then select Control Panel from the Start menu. 
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3. Open the Fonts folder 

 

It is possible to use the run command to directly access the Fonts. Press the Windows key 
and the R key to activate the Run command dialog, then type in the command: 

control Fonts 

4. Select the File menu 

5. Select the Install New Font submenu 



    36 

 

6. Navigate to the temporary folder where you’ve stored the fonts you wish to install 

 

7. Click the Select All button 
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INTERNET EXPLORER 6 

 

There are a number of settings within Internet Explorer that can be configured to control the 
behaviour of Internet Explorer. It is possible to configure the default fonts that Internet Explorer 
uses. If a web designer does not specify a font or if the font specified in the web page or style sheet is 
not installed on your computer, then the browser will use the fonts specified in the browser’s 
preferences. It is also possible to specify the preferred languages of the user. This information is sued 
during language negotiation between a web browser and a web server when the web site contains 
multiple languages and been configured to send the user the web page in their preferred language. It is 
unlikely you will need to change the preferred language settings. 

 

CUSTOMISING DEFAULT FONTS 

 

1. Select the Tools menu 

 

2. Select the Internet Options submenu 

 

3. Click on the Fonts button 
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4. Choose the language script, you wish to select fonts for, from a dropdown menu 

 

5. Select the required Web page font 
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6. Select the required Plain text font 

7. Click on the OK  button 
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INTERNET EXPLORER 7 

 

CUSTOMISING DEFAULT FONTS 

 

1. Click on the Tools button in the internet Explorer toolbar. 

2. Select Internet Options 

 

3. Click Fonts button 
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4. Select a Language script 
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5. Select your preferred proportional font as the Webpage font, and select your preferred  
monospaced font as the Plain text font. N.B. Not all writing scripts will have an 
available monospaced font. 
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FIREFOX 3 

 

CONFIGURING PREFERRED FONTS 

1. Select Options from the Tools dropdown menu. 

 

2. Click on the Content icon in the Options dialog box. 
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3. Click on the Advanced button in the Fonts & Colours section 

 

4. Select the writing script 
 

5. Select appropriate fonts for each category: serif, sans serif and monospaced. 
 

6. Set preferred style for proportional fonts (serif or sans serif) 
 

7. Click on the OK button 
 

8. Click on the OK button 
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APPENDIX 

VISTA RUN COMMANDS 

 

Command  Description  

intl.cpl  Opens Regional and Language Options dialog (Formats tab)  
control.exe intl.cpl  Opens Regional and Language Options dialog (Formats tab)  
control.exe intl.cpl,,0  Opens Regional and Language Options dialog (Formats tab)  
control.exe intl.cpl,,1  Opens Regional and Language Options dialog (Location tab)  

control.exe intl.cpl,,2  
Opens Regional and Language Options dialog (Keyboard and 
languages tab)  

control.exe intl.cpl,,3  Opens Regional and Language Options dialog (Administrative 
tab)  

control.exe Fonts  Opens Fonts folder  
control.exe input.dll  Opens Text Services and Input Languages dialogue  
msinfo32  Opens System Information window  

 

WINDOWS XP RUN COMMANDS 

 

Command  Description  

intl.cpl  
Opens Regional and Language Options dialog (Regional 
Options tab)  

control.exe intl.cpl  
Opens Regional and Language Options dialog (Regional 
Options tab)  

control.exe intl.cpl,,0  
Opens Regional and Language Options dialog (Regional 
Options tab)  

control.exe intl.cpl,,1  Opens Regional and Language Options dialog (Languages tab)  
control.exe intl.cpl,,2  Opens Regional and Language Options dialog (Advanced tab)  
control.exe Fonts  Opens Fonts folder  
control.exe input.dll  Opens Text Services and Input Languages dialogue  
msinfo32  Opens System Information window  
msinfo32 /category 
SWEnvLoadedModules  

Opens System Information window to the LOADED MODULES 
category in SOFTWARE ENVIRONMENT  

msinfo32 /categories 
+SWEnvLoadedModules  

Opens System Information window, only providing access to the 
SYSTEM SUMMARY and the LOADED MODULES category in 
SOFTWARE ENVIRONMENT 

 


